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Overview 

The creation of an Orthographic set of drawings in Pro|ENGINEER Wildfire5® is very 
simple once you get the hang of it but can appear daunting when you first approach the 
procedure. 

 

The first thing you have to keep in mind is that what you are creating is a particular way 
of looking at a three dimensional object.   

 

In the diagram below you can see the relationship between various aspects of the 
outputs available from Pro|ENGINEER Wildfire5®.  The various part models (*.prt) can 
be assembled to form complex assemblies (*.asm).  Both parts and assemblies can be 
shown as drawings (*.drw).  Whilst not part of this tutorial, the models can also be 
shown as rendered images; simulations and animations; and behavioural models using 
the Finite Element Analysis (FEA) part of the Schools Advanced Edition.   
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For Orthographic drawings, often called Detail Drawings, Pro|ENGINEER Wildfire5® 
merely represents this 3D object using whatever standard you have chosen.   

The diagram below summarises the relationship between the 3D model or assembly; 
the engineering drawings and the various ways that the program creates the drawings 
and sets the agreed standards for that particular set of orthographic drawings.  
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Firstly, make sure you have the correct drawing setup file (*.dtl) referenced in the 
config.pro file.  The standard ‘look’ of orthographic drawings will vary depending on the 
part of the world you are in and which particular set of standards you need to use to 
communicate your ideas with others.   In the United Kingdom the British Standards 
Institute set the agreed standard, the current one for schools being BS8888.   In other 
areas the ISO (International Organization for Standardization) or ANSI (American 
National Standards Institute) standards apply; if you work in these areas you will need 
to set the Configuration File to suit your standard. 

In Pro|ENGINEER Wildfire5® there are a number of batch files (*.bat) in the 
‘pro_standards’ folder of the program.  Activating the appropriate batch file will set the 
config.pro file to the correct standard for your needs. 

To create a drawing you will also need a Format, this file is the ‘look’ of your drawings.  
The Format can also be overlain with a Template that positions the views and creates 
the text height, line type etc. This is controlled by the *.dtl file which could be the default, 
in this case the bs8888.dtl file, or a specially created one called the Active Drawing File 
which will only affect the drawing to which it is attached.  If a Bill of Materials (BOM) is 
required, a ‘bom’ table can be inserted into the Template that can extract the necessary 
information from the Bill of Materials contained within the assembly file. 

 A drawing format file (*.dtl) can be tailored to a specific set of drawings and saved 
under a name, e.g. Oil_Box.dtl in which special changes are made to suit the needs 
of this set of drawing. This is the Active Drawing file. 

 If a Template is used its drawing format file (*.dtl) file will determine the outcomes 
unless overwritten by an Active Drawing file. 

 If no template is used then the Global dtl file, e.g. bs8888.dtl, will be used.  
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To assign a dtl file to the config.pro file 

 

 

1. Open the pro_standards folder in the C:/Program Files/Pro|ENGINEER Schools 
Edition. It will look a little like the one above. Read the README.txt file therein 
(reproduced below) 

Dear Pro/ENGINEER Users, 
 
The PTC Education Group has provided a number of batch files to help 
set your default units quickly and easily. 
 
If you choose the "Metric" option during the installation of 
Pro/ENGINEER Wildfire 5.0, it is installed using  
the MMKS Unit System and ASME drawing standard. 
 
If you choose the "English" option, Pro/ENGINEER Wildfire 5.0 is 
installed using the  
INLBS Unit System and ASME drawing standard. 
 
You can easily reconfigure your installation to follow a different 
Unit System and/or Drawing Standard  
using one of the supplied configuration .bat files as follows: 
 
1) Exit Pro/ENGINEER. 
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2) Double-click one of the five ".bat" files to configure your 
Pro/ENGINEER Education installation for a desired  
   Unit System and Drawing Standard: 
 
     configure_for_asme_inlbs.bat – ASME standard drawings with INLBS 
unit system 
     configure_for_asme_mmks.bat – ASME standard drawings with MMKS 
unit system 
     configure_for_bs_mmks.bat – BS8888 standard drawings and an MMKS 
unit system 
     configure_for_iso_mmks.bat – ISO standard drawings and an MMKS 
unit system (1st Angle Projection & Commas) 
     configure_for_STANDARD_UNIT-SYSTEM.bat - For advanced users only, 
this can be edited to create your own custom setup. 
 
3) Restart Pro/ENGINEER 
 
*** Notes: 
 
1) To configure your installation using the supplied .bat files, you 
must have read/write access to the your  
   Pro/ENGINEER loadpoint folder (and subfolders).  This folder is 
typically "ProENGINEER Schools Edition". 
 
   In Windows 7 and Vista, this typically requires you to disable the 
UAC (User Account Control) and restart your computer. 
 
2) Prior to running a configuration .bat file, you will see drawing 
templates for BOTH MMKS-ASME (A1,A2,A3,etc)  
   and INLBS-ASME (A,B,C,etc) drawing templates.  You should only use 
the templates that are relevant to your  
   unit systems.  
 
3) The following folders contain drawing standard specific Drawing 
Templates: 
 
     templates_asme_in – Inch length unit, ASME standard drawing 
templates, Sizes A,B,C&D. 
     templates_asme_mm – MM length unit, ASME standard drawing 
templates, Sizes A1,A2,A3,A4. 
     templates_bs_mm – MM length unit, BS8888 standard drawing 
templates, Sizes A1,A2,A3,A4.  
     templates_iso_mm – MM length unit, ISO standard drawing 
templates, Sizes A1,A2,A3,A4.(1st ANGLE PROJECTION). 
In my case I have activated the one in bold above 

2. Double Left-Click the appropriate batch file.    

3. Now when you start the program the relevant standard is set. 

If you want to use the default set of Formats and Templates then this is all you need do 
to set things up.  However if you notice some anomalies in your drawings then you may 
have to edit the *.dtl file, to do so see Appendix 1. 
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Above is an example of a Drawing Setup File (*.dtl).   

 

About Drawings 
Using the Pro|ENGINEER Drawing mode, you can create drawings of all 
Pro|ENGINEER models, or import drawing files from other systems. You can annotate 
the drawing with notes, manipulate the dimensions, and use layers to manage the 
display of different items. All views in the drawing are associative: if you change a 
dimensional value in one view, Pro|ENGINEER updates other drawing views 
accordingly1.  Moreover, Pro|ENGINEER associates drawings with their parent models. 
The model automatically reflects any dimensional changes that you make to a drawing. 
In addition, corresponding drawings also reflect any changes that you make to a model 
(such as the addition or deletion of features and dimensional changes) in Part, 
Sheetmetal, Assembly, or Manufacturing modes.   

 

 

 

 

                                            
1 Only those parametric dimensions used to create the 3D model can do this.  Extra dimensions added 
manually cannot.  



 

Detailed Drawings Module 
Detailed Drawings extends the drawing capability of Drawing mode. You can use it with 
Pro|ENGINEER to create, view, and annotate models and drawings. 

Detailed Drawings support additional view types and multisheets, offers numerous 
commands for manipulating items in a drawing, and lets you add and modify different 
kinds of textual and symbolic information. In addition, you can use it to customize 
engineering drawings with sketched geometry, create custom drawing formats, and 
make multiple cosmetic changes to drawings.  

With Detailed Drawings, you can also use a shortcut menu to modify any object in a 
drawing from anywhere in the model tree.  At any time when a drawing window is 
active, you can interrupt your current process and activate a drawing object for 
modification. 

With Pro|ENGINEER Interface or Detailed Drawings, you can access various interface 
commands for exporting drawing files to other systems and importing files into drawing 
mode. 

To understand the views you can get from your model or assembly, in your 3D model, 

use the Saved Views ; here you can set Front, Top, Left, Right, Trimetric and 
Isometric views plus a few others.  Try it now, in the modelling mode; alter the model to 

No Hidden, (Left-Click ) as you do so.  You will soon see how Orthographic and 3D 
views are related in Pro|ENGINEER Wildfire5®. 

Above is the LEFT view, to the right is 
the FRONT view and below is the 
TOP view.   Note how one relates to 
the other.  The datum planes on show 
should help you understand this. 

DTE Consultancy 10



 

Create a New Drawing 
With a 3D model open on the screen 

1. Left-Click File then click New   

2. Select the ‘Drawing’ radio button 

3. Type in a name for your drawing file 

 

4. Make sure the ‘Use default template’ 

box is ticked. 

5. Left-Click  

 
 

 

 

6. Pick the drawing size you want and 

Left-Click  

 

 

 

Depending on the part or assembly you have open on the screen; the design of the 
format and template you use, you will now get the 2D drafted representation you 
require.  It will not be complete but of that later. 

(Note: If you have Datum planes and Coordinate systems  open to view then they 
will appear in the drawing.    Just turn them off and Left-Click anywhere in the Graphics 

window to see them disappear or Left-Click repaint or Ctrl+R ) 
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If you look at the picture above you will see what is meant.  There are certain elements 
missing; i.e. dimensions and some elements may be wrong for your standard; the 
representation of the filleted corners for example.  Note the blue line (pre-selection 
highlight) around the view that will help us change things.   Note also such things as the 
border around the edge, the folding guides and reference numbers, the text boxes etc.  
This is known as the Format and you can create your own format.   The three views 
haven’t appeared by magic.  Their position and appearance is due to another file that 
overlays the format and is called the Template.  It is the combination of your model, the 
format and template that makes the drawing unique (see diagram on the next page). 

 

First take a close look at the screen shot and note that it has a new feature, this is 
called the Ribbon Interface. 
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Each tab on the ribbon allows different options into play.  

Select each drawing tab to observe the functionality found in each: 
• Layout – Sheets, formats, views, display settings and drawing 
objects are controlled from this tab. 
• Table – Tables are created and edited using tools in this tab. 
• Annotate – Dimensions, notes and tolerances are shown, created 
and controlled using tools in this tab. 
• Sketch – 2D draft entities can be sketched using tools in this tab. 
• Review – Update your drawing, compare different versions, query 
for information and take measurements using tools in this tab. 
• Publish – Preview, print and export your drawing from this tab. 

As we progress through the tutorial these features will be addressed in more detail.  

Relationship of model and drawings  

 

 
This is the model, it appears in the final 
sheet which is made up of the format; 
the template that places the views and 
finally the drawing with the views in 
place. 

7. Double Left-Click on the blue line, it goes red indicating selection, the following 
dialogue box appears, the use of this will allow you to modify the views. 

 

 

Note: The list of categories down the left 

hand side. 

8. Left-Click each and see what you 
get.  

9. You can play about with the options 
and if you Left-Click the  
button you can see how the view 
changes; if you don’t like it change it 
back.    
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The important one at this stage is the 

View Display.  Here we can show or hide 

Hidden lines and remove tangent edge 

display. On our own templates, created 

later, we can automatically set these 

functions. 

10. If you want to show hidden lines and 

no tangent edges then choose as 

shown here.    

11. Once you have finished Left-Click 

 or  then  

 

 

 

Adding Dimensions 
1. Select the view that you want 

to add dimensions.  Left-Click 
the Annotations Tab in the 
Ribbon Inteface.Left-Click the  
blue line, you will find it by 
floating the mouse near to the 
view. 

2. Left-Click Show Model 

Annotations and the 
following floating menu will 
appear. 

 
 

 

3. Left-Click Show All Dimensions.  
Don’t panic, I know there are a 
lot and they are in the wrong 
places.  We will proceed to 
edit their position and remove 
the unwanted. 

4. Left-Click OK 

5. If you select the view again 
and Right-Click; In the Floating 
Menu you will see the option 
to Cleanup Dimensions.  This 
allows you to quickly move 
things about so you can see 
the wood from the trees. 
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The Offset is for the first dimension and 

defaults to 12.5mm, each subsequent 

(Increment) dimension is 5mm on from 

the offset.  A set of dotted guide lines is 

shown to help set them up.  These can 

be deleted as explained below.  To not 

show them uncheck the Create Snap 

Lines box 

For the moment just accept the defaults 

6. Left-Click    

 

 

 

 

 

 

 

7. Now Left-click to select and Delete all the hatched guide lines; (Use the Ctrl 
key to select multiple lines and then hit the Delete Key (see drawing above) 
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8. Now select those dimensions you want to delete, either one at a time or 
multiple select using the Ctrl Key select with a Left-Click then Right-Click 
and select Erase.  (If you hit the Delete key they will disappear immediately) 

The dimension(s) will grey out and only disappear when you select the next one or 
anywhere in the Graphics Window.  This gives you the opportunity to Right-Click and 
Unerase if you accidentally choose the wrong one.  Whilst you are doing this you can 
also Left-Click-Drag to reposition the dimension and/or the value.   

9. Spend some time ‘tidying up’.   

10. In Pro|ENGINEER Wildfire5® you can move a dimension from one view to 
another. The procedure is very simple. 

a. Select the dimension to move with a Left-Click 

b. Right-Click and select Move item to view 

c. Select the view to receive the dimension. Note: It has to be one that has 
the feature orientation that is suitable. 

 

 

 

11. You can add a note to a dimension 
value by Double Left-Click the value 
and follow the instructions in the 
dialogue that appears.  As shown here 

 

 

 

 

You can alter a lot of things on these three 

boxes to determine exactly what you want. In 

this example we have added the prefix “4 X” to 

the Ø@D. (This is the code for the Ø5mm of the 

four mounting holes.)  This is neater than 

dimensioning each one.  

 

Your view will now look a bit like this. 
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12. You can now manually add 
dimension using the same 
technique as in the 
Sketcher.    

13. Select the Create Standard 

Dimension Tool from the 
Toolbar 

14. Also Align Dimensions. 
First selected will be the 
datum. Other will align to it. 

 

 

 

 

15. Left-Click to select the first 

object of the dimension; 

edge, axis, etc., Left-Click 

the second object.  
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16. Then Middle-Click where 

you want the dimension 

placed. 

 

Note: These added dimensions are 

not parametric and will not change 

the model if you try to change them in 

the drawing. 

17. To add Centre Lines (Axis) 

Left-Click the view on which 

they are to be placed.  

18. Left-Click  and select the 

Axis Tab. 

19. Put a check in the box of 

the Axis you want, or select 

all. 

20. Left-Click    
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Notes can be added as can a Bill of Material (BOM) table and much more.  If you want 
to use this function see the section To Add a Bill of Materials (BOM) Table. 

Remember that these apparent drawings are in fact representations of 3D objects and 
assemblies.  As such any changes made to them will be reflected in these drawings.  
This Associativity is an important productivity aspect of Pro|ENGINEER Wildfire5® .  
You can try it by opening the part,  

1. (Right-Click in the Navigation window on the part and choose Open),  

2. Change a feature of the part or add an extra chamfer.  Now go back to the drawing 
and see that the change has already been made.  

3.  In some cases you may need to regenerate. Left-Click the drawing.  This is the 
essential difference between a 3D modelling CAD and a 2D drafting CAD. 

Adding new sheets 
You can add sheets to the file.   

1. Left-Click  New Sheet on the Layout 
Tab. This will come in as a blank 
format onto which you can place 
general and projected views, create 
sections or even exploded views.  
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Pictorial Views 
When you create your part or assembly you also can create views using the View 
Manager. Also with View Manager you have the ability to set special 3D views that 
best show your model.   These views can also be used within drawings.  

To create a special view move the model in the Graphics Window as required.  

1. Open the View Manager    

2. Left-Click<Orient , 

3.  Left-Click<New and type a name e.g.3D.  

4. Close the View Manager. Return to the Drawing window 

5. On the new blank sheet Right-Click and select from the menu Insert General View.  
6. Left-Click on the sheet, where you want to place the view.  The drawing view 
dialogue box opens to allow you to finalise the view. 

 

It opens in View Type.   

1. Type in a model name and then scroll 

down the list of Model View Names until 

you find the one you want. Trimetric, 

Isometric and your own 3D views are all 

available.  

2. Left-Click ; notice the view is 

shaded as it appears in the part modeller.  

Use other functions in the Drawing View 

dialogue to set other aspects of the view 

as you desire, in the same way as 

described previously.  To set a different 

scale go to the Scale category and select 

Custom Scale, place a decimal number 

to represent your needs, e.g. 2.0 will 

double the scale from the default.    

 

 

 

 

On completion Left-Click then . 

You will notice that the view is locked in place.  If you want to re-position the view on the 
sheet you will need to select the view, (Red line around it); Right-Click and un-tick Lock 
View Movement then Left-Click-Drag to the new position.  To lock the view again, reverse 
the procedure.  You can place more than one view on the same sheet.   
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In this case the right hand view is a specially created one called 3D and it is shown with 
Hidden detail showing.   These appear as greyed out lines but will print-out or plot using 
whatever standard you have set; they appear as dashed lines in BS8888 for example. 

 

Creating a sectional view 
To create a sectional view you have to start in the part /assembly file.  The simplest way 
of creating a section is to make sure there is a datum plane lying just where you want 
the section to be.  You can either use the ones created when the model was made or 
you can place a plane with its sole purpose being to create a sectional view. 

 

You can also create a sectional view within the drawing file itself; see the section 
headed ‘Sectional View Created in the Drawing file’.   Creating the sectional view within 
the model does allow you to see the finished section and also use it to create a 3D 
sectional view, something unique to 3D Modelling packages. 
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1. Activate the View Manager and select 
the Xsec tab.   

2. Left-Click New; type a name or letter 
and hit return.  You will be presented 
with some choices in the Menu 
Manager. 

 

 

 

3. Accept the defaults and Left-Click 
Done.  The Menu Manager changes and 
you have to create or select the 
Datum Plane you intend to use as the 
cutting plane. 

  

 

 

4. In the Graphics window select the plane required. You will be then back in the View 
Manager. 

5. Left-Click Display, Select Set Active and the model will be sectioned to show how it 
will appear.  If you want to cut off the opposite side Left-Click Display Flip. 

 

 

The view will appear as below. To return to 

normal view 

Double Left-Click No Cross Section. 

You can go on and create as many 

different sections as you think you require.  

When complete  the View 

Manager. 

 
 

 

 

You can now go to the drawing view and create the sectional views you require. 
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6. Create a general or projected view on the sheet, this view will be sectioned. To 
create a projected view. Select the parent view; Right-Click and select Insert 
Projected View.  A ghost of the view will appear Left-Click when you have positioned 
it.  Whether it is a 3rd Angle or 1st Angle will depend on how you have set up the 
Drawing Options File (see Appendix 1). 

 

A. 

a. Select the view with a 

Double Left-Click to open 

the Drawing View box. 

b. Select the Sections 

Category 

 

 

 

7. Left-Click select the radio button 
2D cross-section 

8. Left-Click the “+” and the available 
Xsec will appear.  Note: Some 
will obviously not be possible on 
some views. 

9. Left-Click to select the one you 
want and Left-Click . The 
view will change to appear as 
below. 
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Left-Click Close  

Select the view and Right-Click select 

Add Arrows and then choose the view 

to which the arrows should be 

attached.  

The view will now look something like 

this, see below. 

If the hatching is too widely spaced or 

at the wrong angle Double Left-Click 

on the selected hatching and a Menu 

Manager will appear that will let you 

change whatever is needed to create 

the right effect.  The Section title can 

be repositioned by Left-Click-Drag.   

To remove hatching from any part 

select it by Double Left-Click and set 

the spacing so wide that it disappears. 

 

 

 

Sectional View Created in the Drawing file 
If you have not created the sections within the model file it is still possible to create the 
section from within the drawing window. Ensure you have the Datum Planes visible and 
a Projected view created that will be sectioned. 

a. Select the view with a 

Double Left-Click to open 

the Drawing View box. 

b. Select the Sections 

Category 
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At this point there will be no Xsec in the box. 

 

1. Left-Click  ‘+’ and Create New 

2. Select Planar<Done 

3. Enter a Name or Letter 

4. In the Menu Manager Plane will be highlighted if not select it. 

5. In the graphic Window Left-Click the Datum plane to be used (in an 

assembly use a ASM datum plane, you may need to Right-Click and 

use Pick from list to find the required plane) Or select from the Model 

Tree 

6. In Arrow Display select the view in which the arrows will be 

displayed. 

7. Left-Click OK 

 

 

 

Enlarged Details 
To create a detail is quite easy.  It is in three parts, first select the feature you want to 
highlight; then create a spline curve surrounding the part; then place the detail view.  If a 
sectional detail is selected then the detail will be a section.   

1. Left-Click Insert<Drawing 
View<Detailed 

2. Left-Click to select the feature, 
edge or face etc.  A cross will 
appear that indicates the centre of 
the detail. 

Move away from the centre cross and 

create a spline curve surrounding the 

detail.  (There is no need nor is it 

possible to use the Sketch Spline tool )  

3. You do not have to complete the 
curve, when you get close Middle-
Click and a dashed circle will 
appear. 
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4. Left-Click in the position you want the detailed view and it will appear. The default 
scale is 2:1(set in the *.dtl file) but Double Left-Click the scale value to enable it to 
be varied. 

 

 

The sheet will now look like this.  Dimensions can be added to detailed views. 

 

Offset or Stepped Section 
 

There is occasionally the need to create a sectional view that uses a set of offset lines 
or steps to define the section cutting plane. To do this is not difficult but requires a clear 
approach to the objective. 
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Here is an example of a Stepped or Offset Section, Note that lines denoting the steps 
are not shown in the sectioned view, however since this is an assembly the hatchings 
are separate.  

Follow the instructions to create a Stepped section 

1. Insert a general view to be the 

parent of the Stepped Section 

or choose an existing view. 

2. Right-Click and from the 

floating menu select Insert 

Projection View and place it. 

3. Double Left-Click the 

projected view and choose 

Sections from the 

Categories list in the 

Drawings View dialogue. 

4. Choose 2D section  

5. Choose  

6. Choose Offset < Bothsides 

7. Choose Done and enter a 

letter in the dashboard area to 

label the section, hit Enter 

 

 

Your sheet should look like this. 
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What happens now is that a new 

window opens that is very much 

like the sketcher.  Notice the face 

on which we are to place the 

stepped line has been selected.    

 

 

 

 

 

 

Select the face and accept all the 

defaults.   

8. A References window opens 

. 

9. Left-Click to select 4 edges to 

enclose the area on which to 

sketch the stepped line as 

shown opposite. Close the 

reference dialogue. 

 

 

 

 

 

 

10. Left-Click Sketch < Line<Line 

 

 

 

 

 

 

 

 

DTE Consultancy 28



 

 

 

11. Sketch the stepped line as if it 

where in the sketcher starting 

at one of the reference edges 

and finishing on another 

reference edge.   Use the 

automatic Horizontal and 

Vertical Constraints, there can 

be no lines at any other angle. 

 

 

 

 

12. This line can be dimensioned in 

the same way as in the 

sketcher. Select Sketch 

<Dimension <Normal.  Use 

the Constraints tool to align 

with axis and any other feature 

necessary 

13. To complete the line creation 

choose Sketch < Done 

 

 

 

 

 

 

 

 

 

14. Select the view for the arrow 
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display as shown opposite.   

15. Choose View Display to 

modify the view as required to 

show hidden line and tangent 

edges  etc.,  Left-Click OK 

16. The stepped sectional view 

now appears and can be 

modified as required.  Note: 

The hatching of the shaft is not 

to BS8888 and therefore needs 

to be removed. The next 

section deals with modifying the 

hatching lines  

 

 

 

 

 

 

Modifying Cross-Hatching display 
 

Double Left-Click on any of the 

hatching lines in the view.  This will 

bring up a Menu Manager with a 

number of options. 

 

 

The top part of the box allows a choice 

of options about what to modify and the 

bottom part where to modify. 

 

Changes can be made to the spacing, 

the angle, the offset or the line style. 

Since this is an assembly there are 
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more than one section that is hatched. 

Changes can be made to all the 

hatchings (Overall) or each one 

separately (Individual).  You can 

choose which one on which operate 

either in sequence (Next Xsec; 

Previous Xsec) or by selection (Pick 

Xsec). 

 

1. Select the Xsec to modify 

2. Select the value e.g. Spacing 

3. Select Half or Double or Value 

(Note: to remove a hatching select 

Value and state an absurdly large 

value  e.g. 2000mm in the 

dashboard) 

4. Select another value to modify or 

move on. 

5. Choose Next Xsec to move to the 

next in sequence to modify. 

6. When all modifications are 

complete choose Done and the 

view will reflect those changes. 
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Exploded Views 
The exploded view has to be created via the View Manager within the assembly file.   
The details of how this done is the subject of another tutorial.  Once the exploded view 
is created it can be placed in the same way as described for pictorial views.  

 

 

An example of an exploded view with a BOM table and balloons. 

 

Other Views 
It is possible to create other views:- 

 Offset Sections  (Stepped Section) 

 Revolved Sections 

 Breakouts 

 Broken Views 

 Auxiliary Views 

To cover these other aspects of detail drawing visit the COACH Training site at:- 

http://schools.ptculms.com/cadtrain/coachlms/client/login?eventType=logout  
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To create a customised exploded view 
 

There a several ways to create a new exploded view but all are associated with the 
View Manager.  This multi functional tool allows you to create Xsec (Cross-sectional), 
Styles, Orientations and simplified representations (SimpRep). 

 

         

 

To create a new exploded view you are going to do three things. 

 

 Select whether to move one part at a time or multiple parts 
 Select the direction in which they are to move 
 Drag the parts to their required position 

 

1. To start open the View Manager and Left-Click on the Explode tab. 
2. Right-Click on the Default Explode and select Copy, accept the name given 

(Exp001) or change it to something you want. Left-Click OK. 
3. Right-Click on the new name and select Set Active, the red arrow will appear 

on the left and the model will explode in the same way as the default.  You are 
now going to edit this to create a custom exploded view 

 

4. Left-Click the down arrow to the right of Edit. (as 
opposite) 

 
5. Left-Click Edit Position.  

 

6. Now Left-Click in the graphics 
window on the part you want to 
move.  A coordinate axis appears. 

If you float the mouse over it the 
three coordinates highlight in turn. Select the one required for 
the drag direction .  

 
7. Left-Click-Drag to move the part in the direction required. 
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8.  Position all of the parts as required then Left-Click the Green Tick in the 
dashboard 

   

 

 

 

Take your time creating the exploded view as it will be used in the detail drawing.  
Tip: Create several different Exploded Views to cove all the options; don’t try to do 
too much with each one. 

 

9. You will notice the + sign next to name of the view in the view manager.  This is 
an indication that to continue you need to save the view.   Left-Click Edit and 
select Save from the drop down menu. 

 

 

 

10.  Make sure the name is correct and Left-Click OK. 
 

The exploded view is now saved and can be called at any time in the graphics window 
and in any drawing created from the assembly.   
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To call the view open the View Manager and Double Left-Click the view you want to 
select.  Go to View<Explode and select Explode View from the slide out menu.  
Reverse the procedure to un-explode the view.   

 

You can select a number of ways to edit the position to explode the parts, experiment to 
find the one that suits your requirement. 

 

Example of a custom exploded view. 

 

More with Annotation. 
 

The Annotation Tab allows a wide range of actions with selected views. Especially the 

Show Model Annotations Icon .  

On a sheet like that left you must first Set the Model in the Layout tab. As can be seen 
here the OIL_BOX.prt is the selected 
model as its model tree is visible.  
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To change to another model  

1. Left-Click File<Drawing Models. 

2. Select Set Model and from the list presented choose the model you wish to 
annotate. 

3. To annotate that model Left-Click  Follow the instructions in the box that 
appears. Left-Click the part name in the Model Tree. 

 

 

 

 

 

 

 

 

 

 

 

 

The first tab is dimensions and they appear with the views associated with this part. 

4. Place a tick in the box next to the dimension required, it will not be fixed until you 
exit the process. Selected dimensions change colour.  

5. Left-Click any of the other tabs to add those elements if they are present in the 
model. 

6. Left-Click OK to complete the process. 
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To Change the Format Sheet 

If you have created a drawing on a 

generic format and want to change it 

onto a new format it is quite simple. 

1. Left-Click File<Sheet Setup 

The Sheet setup dialogue opens 

2. Left-Click on the down arrow to the 
right of format and either select the 
new one from the list supplied or 
select browse and find the one you 

want.  Left-Click  

 

 

3. Follow the instructions supplied at 
the top of the screen, if they 
appear.  These will usually be to 
keep or remove tables on the 
existing format.  A blank <CR> will 
retain them.   

4. Left-Click the green tick in each 
case.  The new format will appear 
with all your views in place.  There 
is no need to alter anything unless 
you want to or, in the case of a 
sheet size change, larger or 
smaller, then some view 
movement will be required. 

 

 

 

 

Old Format 

New Format 
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To Create your own Format 
The first thing you need to do if you want your own customised Format is to decide what 
it is going to look like.  The best way the do that is to draw one out roughly on the 
relevant sized sheet of paper.  As an example we are going to create an A4 sized 
Landscape format.  Here is the rough sketch. 

 

This is the guide to help you. You now have to determine how each element will be 
made.  You can start with an existing format and make alterations or you can start with 
a ‘clean slate’. In this case we are going to use a PTC format and modify it.  

 

Let’s look at the elements we intend to add. 

 A school or class logo; this needs to be a bitmap file and you need to know where it 
is so that you can retrieve it. 

 A border; this can be drawn using the sketching tools or modified from the existing 
format. 

 A title or Project name; this will be text and can be added as a note and formatted 
with the tools available. 

 A Table; this is a block of cells that contain written or symbolic information.  A Table 
in Pro|ENGINEER Wildfire5® is a powerful entity, not just a series of boxes.  The 
boxes can be ‘programmed’ so that specific information can appear automatically or 
the user can be prompted to input specific information.  (see Appendix 2) 

 A Symbol; this is the universal symbol for 3rd Angle projection and exists as a 
Pro|ENGINEER Wildfire5® symbol. 
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Let us start with the basic format that 

we are going to change. 

 

1. Left-Click File<Open  

2. Navigate to the Templates folder. 

3. Click on the down arrow at the top 
and Left-Click Templates 

4. Set file type to Formats 

 

 

 

 

 

5. Select the one you 
want and Left-Click 

 

 

 

Let us take a good look at this Format to see what we can keep and what we need to 
change or delete to create our own format. 

First of all notice the parts outlined in green.  These are Tables and contain text that is 
interpreted by the program and will return specific parameters to the drawing.  All of 
these parameters are in the Help files and can be found by going to Detailed Drawings 
in the Help Centre and typing Parameters in the Index Tab. (see Appendix 2)   We are 
going to use some of these later.   These parameters MUST be in a Table to be 
interpreted. 

The other aspects such as Border, other lines, fold tabs and reference characters are all 
able to be deleted or left as you see fit.  Save a copy of this Format and then retrieve it 
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to become the new format.  

We will start to make the format as we want by removing the redundant items. 

6. Select the items to delete by LEFT-CLICK. Hold down the Ctrl key to multiple 
select. 

7. Hit the Delete Key 

 

There will be elements you select which will not delete in this way.  These are Tables 
and must be treated slightly differently.  

 

To delete a table 

1. Select the cell first with a Left-Click 

2. Right-Click and Select ‘Delete Contents’.   

 

Some text will remain; this is just a note to tell you what is in the cell.  You can remove it 
later. 

 

3. Select the Table(s) with a Left-Click using Ctrl if necessary. 

4. Left-Click Table<Select<Table 

5. Right-Click Select Delete  

The table will disappear. 

You can now select any text or other odd lines you do not want and delete them 

If there are tables you want to keep and use they can be saved and brought back when 
required. To do this:- 

6. Select the Table 

7. Left-Click Table<Save Table<As Table File   

8. Give it an easily remembered name such as ‘title_block’ 

Once saved, they can be deleted as outlined before.   

 

To retrieve the Table.   

1. Left-Click Table<Insert<Table from File  

2. Select the table you require and position using options from the GET POINTS 
Menu 

Now we can start building up the Format. These are the steps. 

1. Draw any lines you require, you can use the drawing tools to the right of the 
Graphics screen in much the same way as in the Sketcher. 

A useful tip is to set a draft grid.  

a.View -> Draft Grid -> Grid Params.  

b. Set H/V & grid snap Sketch -> Sketcher Preferences.  
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2. Create any text as notes and place them 

3. Create any Tables and populate them with parameters 

4. Place any Logo’s  

 

To start with we are going to create a box 

at the bottom of the sheet using the line 

drawing tool.   

5. First Select the Line Tool   

6. A snapping reference box opens. 
Left-Click the arrow button 

 

 

 

Select the two vertical lines of the border as Snapping References. 

 

7. Draw a horizontal line between the two. Middle-Click to finish. 

8. Drag the Line into the correct vertical position. 

9. Repeat the actions to create a vertical line to enclose the units note. 
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The sheet now looks like this. 

10. Left-Click Insert<Note  

11. A menu manager opens. 

12. Left-Click Make Note to accept the default or make choices as required. 

13. Left-Click where you want the note.  Approximate position is all that is required 
since it can be Left-Click-Drag to exact position later. 

14. In the box at the bottom of the screen type in the note.  If it is only one line you will 
need to Left-Click the green tick on a blank line.  In this example type ‘All 
Dimensions in mm’ 

15. Left-Click  in the Menu Manager 

16. The note will now appear in the default size text set in the drawing set up file, to 
change this (see Appendix 1). 

17. Double-Left-Click on the Text and the Note Properties box opens.  Here we can 
change and edit the note to be exactly what we want. Note: spelling correction 
needed. 

 

  

 

1. Left-Click the Text style Tab, here we can set the size of Text, font used and 
colour of the type.  

2. Make changes and use the Preview button to see what you get. 

3. Left-Click OK when all is done.   

Notice that there is no formatting of the text in a plain note.  If you want the text to have 
a box round it prefix the text with @[. 

Continue to add text as required. 
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To add a Table 
1. Left-Click Table<Insert<Table (or Table from file to retrieve a saved version, 

useful if you are creating a range of formats with similar tables). 

 

 

 

A Menu Manager opens so that you can set out how you like you 

table to look.  In this case we are going to create an ascending 

table Leftward, By Length.  We are going to lock it to the right 

border and the horizontal Line we created earlier by using their 

Vertex, i.e. the corner. This will create a table starting at the 

bottom right hand corner of the sheet.  Looking back at the rough 

sketch we need a table of 2 columns and 4 rows.  We will be 

using drawing units to give the size; it is easier than working out 

how many characters you will put in the cell.   

1.. Select the Vertex.  You will be prompted to enter the width of 

the first column.   

2. Type in the width in drawing units e.g. mm and either Left-Click 

the green tick or hit the Enter key.   

3. The next column width is the entered and so on until you have 

defined all of the columns you need.  In this case stop after two 

columns are defined. 

4. To stop setting columns; <CR> Enter on a blank prompt.  

5. You will now be asked to define the row heights in the same 

way, finishing with a <CR> (Enter) after the last one.  Your Table 

will then appear. 
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You can create other tables in the same way; instead of drawing a box to put the 
symbol in we will use a 1 X 1 table. 

 

2. Add text to the left hand column using the table function. 

3. Left-Click in the cell, the Note Properties box opens.   

4. Enter here the text, if you want to use any special symbols open the Text 
Symbols box.  

5. Open the Text style tab. 

Here you can add font, size, colour and position in the 

cell, etc.,   

 

Use the Preview button to see the affect of any 

changes before you commit. 

 

6. Now it looks like this, you can edit any cell by 
selecting it and Double-Left-Click to return to the 
Note Properties. 

 

 

 

You can now add parameters to the other cells that will be interpreted by the program to 
enter the Date, Scale and Drawing number.  These are of two types, those 
automatically placed by Pro|ENGINEER Wildfire5® and those requiring action on the 
part of the user.   We will deal with the automatic ones first. 

 

 The ones needed in this example are for Scale which is “&scale”; Date which is 
“&todays_date”; Sheet number which is “&current_sheet of &total_sheets”.  These 
you will note have an ampersand preceding the text and no spaces; an underscore is 
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used as in the case of a file name.  (For other parameters see Appendix 2).  These are 
placed and formatted in exactly the same way as the earlier notes.  Enter everything 
between the quotes. See Appendix 2 for other parameters you may need. 

You can enter a user parameter in the same way but this will elicit a user response.  In 
this case the Pupils name in the ‘Drawn By’ cell.  We are going to use the parameter 
“&pupils_name”.  Whatever word or words you use here will be the user prompt when 
the format is employed. 

 

Your Table will now look like this:-  

 

 

(Note: On the format they will appear as typed; when the format is used the relevant 
information will appear. Don’t worry if they overlap the cell, as the value returned will 
not.) 

 

To Add a Logo 
The School badge, Team or Project Logo can be added to the format or drawing, either 
in a cell or not.  In this example the logo will go into the top left hand corner of the sheet.  
It must be a Windows bitmap file (*.bmp) 

 

1. Left-Click Insert<Object 

2. It is better to have it 

already created so select 

Create from File. 
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3. Browse to the file and 

Left-Click   

4. Left-Click on the 

Graphics Window to place 

the bitmap image.  Size 

the image using the drag 

corners and reposition as 

required. 

 

 

 

 

 

To Place a Symbol  

All that remains now is to place the symbol that 

shows it is a 3rd Angle Drawing. 

 

1. Left-Click Insert<Drawing 
Symbol<Custom 

2. Browse to the Folder containing the 

symbol and select it.  This box appears. 

 

  

 

A ghost image of the symbol 

now appears at the mouse 

cursor. 

3. Position the symbol and 

Left-Click to place.   

4. Left-Click  

The Format is now complete.  

Save the file in the Templates 

Folder or a Templates Folder 

in your user area. You can of 

course retrieve it at any 

anytime and modify it. 
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This format can now be used to create your own unique set of drawings.   Here is what 
it looks like when a model is shown. 

 

 

 

These views have been manually placed, now you can use this format to create a 
Template onto which the views will be placed automatically. 
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To Create a Template.  

The template is the file that sets the desired views and their display state; create snap 
lines; and shows model dimensions based on the way the template is created. 

As an example we will create a Template based on an A4 format that will show three 
views in 3rd Angle projection, two of which will have hidden detail showing and none will 
show tangent edges. You can draw a rough sketch to determine how you want the 
views to look. 

1. Left-Click New Drawing 

2. Give the template a name 

e.g. DTE_A4_TEMPLATE. 

The name should tell as much as 

possible about the template. 

3. Select the radio button 

Empty with Format 

4. Browse to find the format you 

want to use.  In this case we 

will use the one created 

earlier. 

5. Left-Click  

6. Left-Click Applications< 
Template 

 

We now have to place the views 

on the sheet. In this case the first 

one is the ELEVATION which will 

be a General view; Orientated 

LEFT (see View Manager); 

Hidden; No Tangent Edges. 

7. Left-Click Insert<Template 
View   The Template View 
Instructions box appears.  In 
this we can first of all set the 
View Name  --ELEVATION 

 
 

 

Now set the Orientation –LEFT   (Note there are many options here, what you use 
depends on the template you are creating.  The Views are those available in the View 
Manager) 

Notice, under ‘View Options’ there are some boxes ticked and others not.  View states 
MUST be ticked the others are optional depending on your template. In this simple 
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example we will only use those options checked. 

 

8. Left-Click ‘Model Display’  select “Hidden” to show hidden detail 

9. Left-Click ‘Tan Edge Display’  select “No Disp Tan” to not show tangent edges 

10. Left-Click ‘Place View’, Left-Click on the Graphics Window to place the view. It 
can be reselected to reposition it if required. 

11. Left-Click ‘New’ to set up the next view; this will be a projection from the 
ELEVATION.  Left-Click the down arrow to the right of the View Type box and 
select Projection.  Ensure that ELEVATION is shown in the Parent View Name 
box. Set Model Display and Tan Edge Display as before and name the view 
PLAN. Place the view. 

12. Left-Click ‘New’ to set up the last view, a Side Elevation Projected from the 
ELEVATION.  No Hidden this time. 

13. You can reposition the views if you wish and by Double-Left-Click on the symbol 
you can edit the view display. 

 

 

 

The views and the view names appear in this view but will be replaced by the views of 
whatever model you use when creating your drawings. 

The last thing you need to do is to re-allocate the two parameters ‘&scale’ and 
‘&model_name’ .  

14. Left-Click to select the cell Double-Left-Click and change what is there to the 
Pro|ENGINEER Wildfire5® parameters  namely ‘&scale’ and ‘&model_name’.   
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They will appear in the template as “DRAWING SCALE” and “MODEL NAME” this will 
appear as the correct scale and model name when the Template is used. 

15. Setup the drawing option file as described in Appendix 1. 

Before saving the Template file you will need to make sure that no models are 
associated with it.  

16. Left-Click File<Properties<Drawing Models 

17. Refer to the dashboard area. If a model is associated it will be noted with the 
option to retain or delete. Left-Click “Yes” to delete 

18. Save the template file. 

 

To Add a Bill of Materials (BOM) Table. 
A Bill of Materials Table is a special case of the use of a Table in drawings.   The table 
is created to show each of the components within the assembly plus other information 
that may be required.  Each cell in the table has a parameter and each cell can be 
made to duplicate itself as many times as is required to cover any size assembly.  Cells 
can also be set to create Numbered Balloons attached to the parts. 

The easiest way to add a BOM table to your format is to copy one from an existing PTC 
format found in the Templates folder.   This one is a simple example but adequate; if 
you want to create a more complex one, see the Help Centre files.  

1. Set Templates Folder as the Working directory 

2. Open the format file with the BOM table 

 

Here is an example of such a file with 
the BOM table showing. 

 

3. Left-Click to select the Table 

4. Left-Click Table<Save Table<as Table File  

5. Give it a name e.g. bom.tbl 

This will save the table in the Templates Folder 

 

6. Close the file and File> Erase<Not Displayed to clear the memory 

7. Open your format file. 
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8. Left-Click Table<Insert<Table from File 

9. Place the Table using a Left-Click-Drag  

10. Left-Click to finalise. 

11. Save the format file 

 

To set the table to create balloons 

1. With the format open 

2. Left-Click Table<BOM Balloons, BOM BALLOONS Menu Manager opens. 

3. Left-Click the Cell ‘ITEMS’ This is where the part no. is stored 

4. Left-Click Simple to provide a balloon with just the number. 

5. Left-Click  

6. Save the format 

 

To Show Balloons in an assembly View 

1. Left-Click Table<BOM Balloons 

2. Left-Click Create Balloons BOM VIEW Menu appears 

3. Left-Click Show All  

4. Left-Click  

5. Drag-Left-Click Balloons into place 

 

You will notice that the table only has one row and is populated with parameters that 
start ‘&asm_’ which collects the data required from the part file.  The table, when used, 
will display all of the components that comprise the assembly.   The table is designed to 
extend to the size required.   
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Format with BOM table used 

 

 
If you wish to place a BOM table into an existing drawing or on format without a bom 
table in place then follow the procedure in the next section. 
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Creating a Bill of Materials for a blank format. 
Creating a BOM in a drawing is a three step process starting with an assembly open in 
Pro|ENGINEER. 

 In the assembly create the bill of materials 

 In the drawing of the assembly insert a BOM table 

 Create BOM balloons for components 

 

Creating the BOM for an assembly 

1. Your assembly should be open in Pro|ENGINEER. 

 

 

2. In standard mode…the BOM will display in the 

browser. 

3. In the main toolbar across the top of the screen 

open the Info menu and select Bill of Materials 

4. The BOM dialog opens 

 

5. Click OK 
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6. The Browser in Pro|ENGINEER will 

open displaying the Bill of Materials 

for the assembly. 

The BOM lists all the components, the 

quantity where there are multiples. 

The columns give access to information 

about components and by clicking on a 

part it highlights in the graphics window. 

 

 

 

BOM tables 

BOM tables are created from assemblies in HTML format and before they can be 
inserted into drawings you will need a template table file.  You can download one called 
bom.tbl from the PTC Education Windchill Project Link site. 

https://pds.ptc.com/Windchill/netmarkets/jsp/project/view.jsp?oid=project%7Ewt.projmg
mt.admin.Project2%3A183631245&u8=1 

Note: It is possible to create your own BOM table template with the necessary 
‘intelligence’ to pull information from the models. (see next section) 
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Inserting a BOM table 

1. With your drawing open 

on screen, 

2. In the Table Tab select 

Table from 

file.   

3. Browse for the bom.tbl 

and place it in the 

drawing somewhere. 

You will see that it already 

has rows for each item. 

 

 

4. Drag the table into 

position on the drawing. 
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Adding BOM balloons 

1. With the drawing open in 

Pro|ENGINEER. 

2. In the graphics window select the 

view you want to display BOM 

balloons. 

3. In the Table Tab Left –Click to 

select BOM Balloons  

4. Select Set Region and select the 

whole table. 

 

5. Select Create Balloon. By view is 

the default. Left-Click to select the 

view you want the balloons to 

attach. In this case the Isometric 

 

 

 

 

The Isometric view will now have 

BOM balloons with leader arrows 

showing each of the components. 

6. Click Done/Return to close the 

BOM Menu. 

 

 

 

 

 

You have placed a table and all the 

balloons. 

The balloons can be selected by Left-

Click and dragged to reposition.  
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To ensure the arrow points correctly:- 

1. Left-Click to select the arrow 

leader. 

2. Left-Click-Drag the arrow 

head to position it on the part. 

 

Note: You can only position the balloon on 

the relevant part. 

 

 

 

To create a new Repeat Regions Table  
 

There are two reasons to create a table that can pick up information from the model or 
assembly file.  The first we have covered already which is the Bill of Materials or ‘BOM’ 
table.  The second is a more complex table that can refer to instances of a part 
contained within a Family Table.  The way this works is based on the principle of ‘smart’ 
table cells called repeat regions.  These are user defined sections of a table that expand 
or contract to accommodate the amount of data that the associated model or assembly 
currently possesses.  

1. The Extended Bill of Materials Table 

 The simple one we have shown so far is adequate for most projects however you may 
wish to add other columns, ‘material used’ for example. 

Shown below is the simple BOM table taken from our format. 

 

 

 

The top row is normal text and will appear in the drawings as just that.  The bottom row 
contains symbols, entered as text but will appear in the drawing as the information that 
the symbol extracts from the model or assembly in the same way as explained in the 
format creating section. 

When the table is updated in the drawing, this is what appears. 
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To create a repeated region table. 

There are three parts to the procedure; the first is to create the blank table with the 
requisite number of columns and rows.  The second part is to define the repeat regions 
of the table.  The third is to populate the table with the plain text headings and the 
parameters that call up the data. 

 

1. Create a table with 2 rows and X columns. (Where X is the number you require.  
You do not need any more than two rows since they will repeat as many times as is 
required.)  See the section ‘To add a Table’* for help on creating a table. 

2.  Populate the top row of cells with the headings required. * 

3. To define the repeat region of the table. 

a. Left-Click cell in the second 

row of the table. 

b. Left-Click  Table 

c. Left-Click<Select< Row  The 

row is now highlighted 

d. With the row still highlighted 

Right-Click and select Add 

Repeat Region from the 

floating menu. 

e. The row is now a set of repeat 

region cells 

 
 

Note: A repeat region doesn’t have to 

be a row it can be anything from a 

single cell to a block of several cells 

depending on your need. 
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To enter the report parameters into the repeat region 

1. Right-Click in the target cell. 

2. Left-Click Properties from the 

floating menu. 
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3. Left-Click   

 

4. We are now presented with a 

set of parameters from which 

to choose; depending on 

choice the next menu will 

appear.   Here we have 

chosen ‘asm..’  then ‘mbr..’ 

then ‘param..’ then ‘unit..’. 

The ‘UP..’ parameter allows us 

to return to the previous menu.  

Once all the parameters are 

defined the complete string will 

appear in the Note 

Properties.  Once the whole 

table is complete a Double 

Left-Click on any parameter 

will bring up the symbols 

again. A Right-Click on a 

selected cell will bring up the 

Note Properties for editing. 

 

5. It is possible to type in the data 

direct to the cell using the 

parameters in Appendix  2.  

The “&rpt” must precede any 

parameter used.   If a User 

Defined parameter is inserted 

this will need to be added 

when the format is used in 

much the same way as the 

‘&pupil_name’ 
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4. The table will now look like this once complete. 

 

The parameters will be replaced by the data drawn from the part and assembly files, or 
from family tables. 
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Appendix 1.  Setting up and editing a Drawing Options 
File. 
The drawing options file, (*.dtl) where * may be ‘bs8888’, ‘iso’ or ‘ansi’ , exists to set the 
default values for many options that appear in drawing.  Unless it it changed for a 
particular drawing the one set in the config pro file will contain all of this information.  
Great care should be taken if these default files are edited. However it is possible to 
copy this file and attach it to the active drawing or template.    

1. Have the Template open on the screen 

2. Left-Click File<Properties 

3. Select Drawing Options from the Menu Manager 

 

 

 

The file opens and can be edited.   Select the option to edit and change its value in the 
right hand box.  Information on the parameter can be read on the Right.  Some options 
require a numerical value others have a range of options that can be selected using the 
drop down menu. 

1. Left-Click Add/Change<Apply; then move on to the next parameter to alter.   

2. Left-Click  and Save the file. 
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The only parameters you will need to change to comply with BS8888 are as follows:- 

‘drawing_units’     this is set ‘mm’ other values are affected by this.   

‘drawing_text_height’     Set as a multiple of the drawing units; e.g. 5 for 5mm high 
text. 

‘decimal_marker’ the default in COMMA change to PERIOD 

‘view_scale_format’ the default is decimal, change to ratio_colon e.g. 1:2 

‘view_scale_denominator’ the default is 0 change a denominator that is suitable for the 
drawing or a large number if many different scales are 
required.  A good general no. is 300 

 

You may change some of the others but I would advise caution and test as you go. 

To edit the global *dtl file  you can open it in a Text Editor and change the parameters 
manually.  CAUTION: This could destabilise your installation 
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Appendix 2   System Parameters for Drawings 
(Taken from the Pro|ENGINEER - Help Centre) 

   PARAMETER NAME DEFINITION 

&d# Displays a dimension in a drawing note, where # is 

the dimension ID. 

&ad# Displays an associative dimension in a drawing 

note, where # is the dimension ID. 

&rd# Displays a reference dimension in a drawing note, 

where # is the dimension ID. 

&p# Displays an instance number of a pattern in a 

drawing note, where # is the pattern ID. 

&g# Displays a gtol in a drawing note, where # is the gtol 

ID. 

&<param_name> Displays a user-defined parameter value in a 

drawing note. 

&<param_name>:att_cmp An object parameter that indicates the parameters 

of the component to which a note is attached. 

&<param_name>:att_edge An object parameter that indicates the parameters 

of the edge to which a note is attached. 

&<param_name>:att_feat  An object parameter that indicates the parameters 

of the feature to which a note is attached. 

&<param_name>:att_mdl An object parameter that indicates the parameters 

of the model to which a note is attached. 

&<param_name>:att_pipe_bend An object parameter that indicates the parameters 

of the pipe bend to which a note is attached. 

&<param_name>:att_spool  An object parameter that indicates the parameters 

of the spool to which a note is attached. 

&<param_name>:EID_<edge_name> An object parameter that references edges. 

&<param_name>:FID_<feat_ID> An object parameter that includes a feature 

parameter in a note by ID. 

&<param_name>:FID_<FEAT_NAME> An object parameter that includes a feature 
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parameter in a note by name.  

&<param_name>:SID_<surface_name> An object parameter that references surfaces. 

&angular_tol_0_0 Specifies the format of angular tolerance values in a 

note from one to six decimal places. 

&current_sheet  Displays a drawing label indicating the current sheet 

number. 

&det_scale Displays a drawing label indicating the scale of a 

detailed view. You cannot use this parameter in a 

drawing note. Pro|ENGINEER creates this 

parameter with a view and places it in notes 

automatically. You can modify its value, but you 

cannot call it out in another note. 

&dtm_name Displays datum names in a drawing note, where 

name is the name of a datum plane. The datum 

name in the note is read-only, so you cannot modify 

it; unlike dimensions, a datum name does not 

disappear from the model view if included in a note. 

Pro|ENGINEER encloses its name in a rectangle, 

as if it were a set datum. 

&dwg_name Displays a drawing label indicating the name of the 

drawing. 

&format  Displays a drawing label indicating the format size 

(for example, A1, A0, A, B, and so forth). 

&linear_tol_0_0 Specifies the format of dimensional tolerance values 

in a note from one to six decimal places. 

&model_name Displays a drawing label indicating the name of the 

model used for the drawing. 

&parameter:d Adds drawing parameters to a drawing note, where 

parameter is the parameter name and :d refers to 

the drawing. . 

&pdmdb Displays the database of origin of the model. 

&pdmrev Displays the model revision. 

&pdmrev:d Displays the revision number of the model (where :d
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refers to the drawing). 

&pdmrl  Displays the release level of the model. 

&scale Displays a drawing label indicating the scale of the 

drawing. 

&scale_of_view_detailed_bar   

&sym(<symbolname>) Includes a drawing symbol in a note, where 

symbolname is the name of the symbol. 

&todays_date  Displays a drawing label indicating the date on 

which the note was created in the form dd-mm-yy 

(for example, 2-Jan-92). You can edit it as any other 

nonparametric note, using Text Line or Full Note.  

  

If you include this symbol in a format table, 

Pro|ENGINEER evaluates it when it copies the 

format into the drawing.  

To specify the initial display of the date in a drawing, 

use the configuration file option 

"todays_date_note_format."  

&total_sheets Displays a drawing label indicating the total number 

of sheets in the drawing. 

&type Displays a drawing label indicating the drawing 

model type (for example, part, assembly, etc.). 

&view_name Displays a drawing label indicating the name of the 

view. You cannot use this parameter in a drawing 

note. Pro|ENGINEER creates it with a view and 

places it in notes automatically. You can modify its 

value, but you cannot call it out in another note. 

&view_scale Displays a drawing label indicating the name of a 

general scaled view. You cannot use this parameter 

in a drawing note. Pro|ENGINEER creates it with a 

view and places it in notes automatically. You can 

modify its value, but you cannot call it out in another 

note. 
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Appendix 3:  To Control the Format of the Date 
The configuration file option todays_date_note_format controls the initial format of the 
date displayed in a drawing. The format for the setting is a string consisting of three 
portions: the year, the month, and the date. You can enter the portions in any order. The 
default value is %dd-%Mmm-%yy.  

 Year 

 %yy, for 97 

 %yyyy, for 1997 

Month (if the month contains two digits (for example, 10),% mm, % m, or % m all 
produce the same result) 

 %Mmm, for Jan  

 %MMM, for JAN  

 %Month, for January  

 %MONTH, for JANUARY 

 %mm, for 01 

 %m, for 1 

 % m, for <space>1 

Date (if 2 digits are needed to represent the date, all three are the same. Therefore, 
"%dd %mm %yy" produces "01 01 97," and "%MMM %d %yyyy" produces "JAN 1 
1997") 

 %dd, for 01 

 %d, for 1 

 % d, for <space>1. 

The following formats are also valid: 

 %dd-%Mmm-%yy (= 01-Jan-97) 

 %mm/%dd/%yy (= 01/01/97) 

 %Mmm %dd,%yyyy (= Jan 01, 1997)  
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Appendix 4.  To create a multiple parts drawing 
 

There will be times when an assembly drawing is not enough; you may need to create a 
sheet that contains detail drawings of several parts of the assembly.   Of course you 
could create a sheet for each part but occasionally you may want to put several parts on 
the same drawing sheet.  

 

1. Open the new sheet or a blank 

format Right-Click and select 

Drawing Models. 

Ensure the Layout tab is 

selected in the Ribbon Interface 

2. Select Drawing models 

3. Select Add Model 

4. The Open dialogue box open. 

5. Open the part you want to add 

to the drawing. 

6. Right-Click on the sheet and 

select Insert General view. 

7. Proceed as for any other type 

of view. 

8. Repeat to add further parts to 

the sheet. 

9.  Note: Each part will be placed 

with a scale selected to fit the 

sheet.  To ensure that the scale 

is known for each, check the 

Custom Scale button under the 

scale tab of the Drawing View 

dialogue box. This will put a scale 

against each part.  Notes can be 

added as required. 

See right for an example. 
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1. To set the model for use, 

Right-Click and select 

Drawing Models. 

 

 

2. Left-Click Set Model and a 

list of the models associated 

with the drawing appear 

3. Left-Click the model name to 

set. 

4. Left-Click Done/Return 

 

 

 

 

 

1. To Add a New Sheet, Left-

Click New sheet on the 

Layout Tab. 

To Move to a sheet Left-Click on 

the particular tab as opposite 

 

 

 

 

 

 

 

 

 

 

 

John Forth – June 2010 
 

 

70


	Contents
	To assign a dtl file to the config.pro file
	About Drawings

	Detailed Drawings Module
	Adding Dimensions
	Adding new sheets
	Pictorial Views
	Creating a sectional view
	Sectional View Created in the Drawing file
	Enlarged Details
	Offset or Stepped Section
	Modifying Cross-Hatching display
	Exploded Views
	Other Views
	To create a customised exploded view
	More with Annotation.
	To Change the Format Sheet

	To Create your own Format
	To delete a table
	To add a Table
	To Add a Logo
	To Place a Symbol 

	To Create a Template. 
	To Add a Bill of Materials (BOM) Table.
	To set the table to create balloons
	To Show Balloons in an assembly View
	Format with BOM table used

	Creating a Bill of Materials for a blank format.
	Creating the BOM for an assembly
	BOM tables
	Inserting a BOM table
	Adding BOM balloons

	To create a new Repeat Regions Table 
	To create a repeated region table.
	To enter the report parameters into the repeat region


	Appendix 1.  Setting up and editing a Drawing Options File.
	Appendix 2   System Parameters for Drawings
	Appendix 3:  To Control the Format of the Date
	Appendix 4.  To create a multiple parts drawing

